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1Introduction

All work should 
be conducted 

with an archival 
preservation 

mindset.

INTRODUCTION

The Cuban Theater Digital Archive (CTDA) is a resource for research, 

teaching and learning in Cuban theater and performance as well as in 

related fields; a community repository for important Cuban theatrical 

materials; and a forum to foster scholarly communication in this field. The 

Digital Archive includes materials digitized and filmed in Cuba and outside 

the island as well as resources and information related to Cuban theater, 

with a special focus on theater produced by Cuban communities in the 

United States.  Our website is accessible in English at cubantheater.org, and 

in Spanish at teatrocubano.org.

To support our mission, we have established a small yet robust 

Digital Video Production Lab at the University of Miami Richter Library for 

the conversion of a variety of video formats to archival video.  The lab is 

equipped with three Mac Pro work stations and video players capable of 

playing most current and recent formats of magnetic tape media.  This 

document provides a comprehensive overview of standards, procedures, 

and workflows in place at the University of Miami Libraries.

When working with video documentation of live theater, we always 

keep two principles in mind: 

1. All work should be conducted with an archival preservation mindset. 

2. In attempting to document theatrical performance on video, we do 
our best to communicate the experience of the audience.

What do we mean by an archival preservation mindset?  Since much 

of our video digitization work involves converting and editing video from a 

variety of sources—whether from archival collections at the Cuban Heritage 

Collection, the private collections of project partners, or newly shot footage 

directly from staff videographers—we are very mindful not to harm or alter 

the original materials that arrive in our lab.  As such, we try our best to keep 

physical handling of the materials to a minimum.  This limits the stress 

placed upon the tape and reduces the chance to harm the object.  Likewise, 

with plays that we shoot directly to digital, we store all original footage in 

We must 
preserve the 
experience 
of the live 
audience.

http://cubantheater.org
http://teatrocubano.org
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its original file format, before any editing or transcoding takes place, on 

an archival file server.  This way, we have something to go back to in case 

any mistakes are made during editing.  For more information about the 

techniques used to record theater, please see the CTDA Guide to Filming 

Live Theater.    

This Technical Guide explains the procedures we use when converting 

legacy materials to digital formats and when working with born-digital 

materials.  It is the result of over a year of research, trial, and error.  

However, there are many more things to learn, so as we tweak or change 

our procedures, we will document them in subsequent versions of this 

document.  At this time, we are calling this version 0.1.    

http://cubantheater.org/about/
http://cubantheater.org/about/
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PROJECT OVERVIEW

The University of Miami Libraries has been digitizing photographs, 

brouchures, maps, and other such items for years. We took that workflow 

and modified it for this project. Along with establishing the video workflow, 

a database was created to help with the process and to keep all of the 

metadata in one place.

DATABASE DEVELOPMENT - ROMEU
The CTDA is powered by Romeu, an open source content 

management system designed especially for the collaborative 

documentation of theater performance.  Written in Python using the 

Django content management framework, it was named after the Cuban 

jazz musician Armando Romeu.  The Romeu system is available for free 

download at https://github.com/umdsp/romeu.  However, potential 

implementors are cautioned that Romeu’s developers have not yet authored 

user comprehensive documentation of the system, which is still in its alpha 

development phase.         

Among its many features, the Romeu system comes equipped with 

a workflow management tool for tracking the status of video digitization 

projects.  Whenever we reference our “database” in this document, we 

are referring to Romeu’s tool for tracking items throughout our workflow.  

However, this workflow could also be adopted by small organizations who 

rely on other tools for keeping track of the status of local video projects. 

The workflow outlined below applies both to converting and editing 

legacy videos in a physical/analog format (VHS tape, DVD, MiniDV tape) as 

well as born-digital videos that were filmed by our videography staff.  

ROLES AND RESPONSIBILITIES
All steps are divided between a Content Specialist, a Digitization 

Specialist, and a Supervisor. The Content Specialist is the person(s) that is 

responsible for the information about the recording: name of performance, 

https://github.com/umdsp/romeu
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director(s), actor(s), location of performance, description, and other relevant 

information; they are also responsible for making sure that the title cards 

and video is correct before the video is finalized. The Digitization Specialist is 

the person(s) responsible for the digitization of the performances, ensuring 

the best possible video and audio presentation for our archive and viewers, 

and they are also responsible for entering the information for the title cards. 

The Supervisor is the person(s) responsible for checking each file to ensure 

that it plays and is named correctly, that all files are archived and placed on 

the presentation server, and that everything is in order before the original 

raw files are deleted from the computer.

GENERAL WORKFLOW
We have two types of video medium to work with; legacy videos in a 

physical/analog format (VHS tape, DVD, MiniDV tape) and born digital videos 

that were filmed by our CTDA staff. This workflow accomodates both types.

1. Create a record in the database for the video.  
This is done regardless of the type of medium and regardless 
of whether or not it can be digitized. This record serves as our 
inventory for the project.

2. Assess the ability of the video to be digitized.  
At times, the tape or disc may be broken, dirty, or otherwise unable 
to play in a player. This hasn’t been an issue yet, but if/when it is, we 
will add that information to the workflow.

3. Create the digital version of the video.  
This part of the process is where the video is captured or copied 
onto the computer. This process is different for legacy and born 
digital videos, so they have separate procedures in this manual.

4. Content Specialist enters metadata for the video. 
The Content Specialist enters the metadata that will be used in the 
title cards. This is needed before the video can be finalized.

5. Post-Processing (editing or correcting) the video. 
Videos are edited at this stage. Legacy materials are edited more 
for quality than content. Additional editing of filmed materials takes 
place when two cameras are used.

6. Create the title cards from the stub record metadata. 
The title cards contain information about the play, including 
title, director, actors, location, and branding of the project. This 
information is input into the database to use on the play’s page as 
well as in the title cards.
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CTDA Workflow:
•	 Step 1: Create a Stub Metadata Record 

in the CTDA Database
•	 Step 2: Assess Physical Material’s Ability 

to be Digitized
•	 Step 3: Create Digital Version (Capture/

Transfer)
•	 Step 4: Content Specialist Metadata
•	 Step 5: Post-Processing (Editing/

Correcting)
•	 Step 6: Title Card Creating (Branding)
•	 Step 7: Upload Files to Final Cut Server
•	 Step 8: Content Specialist Quality 

Control
•	 Step 9: Create Derivatives
•	 Step 10: Supervisor Quality Control
•	 Step 11: Upload Files to Archive Server
•	 Step 12: Upload Files to Presentation 

Server
•	 Step 13: Cleanup Computer and 

Database
•	 Step 14: Finalize Metadata

All steps are divided between the Content 
Specialist, the Digitization Specialist, and the 
Supervisor.
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7. Upload the files to the Final Cut Server for content quality 
control. 
The video is placed onto a server that is accessible to anyone, 
including off-campus, so that the Content Specialist(s) can view the 
video and check that it contains all the contecnt that it should, has 
the correct title card information, and that it plays as best as possible 
(not all errors are able to be corrected without a large investment of 
time).

8. Content Specialist Quality Control 
The Content Specialist(s) logs into the Final Cut Server, views a 
proxy of the video file, and comments on the quality or edits that 
need to be made. If everything is acceptable, they mark the video as 
approved. The Digitization Specilist(s) can see the status by logging 
into Final Cut Server.

  à As of this version of the documentation, we have not had a 
video that needed major post-production editing. If/when we 
encounter one, we will formalize the steps taken.

9. Create Derivatives 
When the video has been approved, the Digitization Specialist(s) 
create five different files: an archival video file, a presentation 
video file, a DVD video file, a DVD audio file, and an MP3 file. Each 
of these have specific settings based on current standards and 
playback settings. In addition to the audio/video files created, a still 
frame is created to represent the video on the website.

10. Supervisor Quality Control 
Each derivative file is checked for playback, content, and standards 
by the supervisor of the project. 

11. Upload Files to Archive Server 
All derivative files are uploaded to the archive server.

12. Upload Files to Presentation Server 
The presentation video is uploaded to the streaming server and the 
still frame image is uploaded into the CTDA Database.

13. Cleanup Computer and Database 
Once everything has been approved and archived, the appropriate 
files are erased from the computer and the Final Cut Server. The 
stub record in the database is updated to reflect that the video has 
been completed and the video is ready to go out to the public.

14. Finalize Metadata 
The Content Specialist checks the stub record one more time to 
ensure that all the information is correct and that the information is 
ready to go out to the public.
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EQUIPMENT

The CTDA Workstation uses the following software and hardware to 

capture and edit video.

COMPUTER:

•	 	Mac Pro

  à Two quad-core 2.4GHz Xeon Processors

  à 16GB RAM

  à 4x 2TB hard drives partitioned as follows:

  ▪ 2TB system drive

  ▪ 6TB RAID for video capture

  à Blackmagic Designs Decklink Studio Capture PCI card

  à Blackmagic Designs Ultrascope PCI card

•	 	27” Apple Cinema Display Monitor

SOFTWARE:

•	 	Final Cut Pro 7.0.3

•	 	Compressor 3.5.3

•	 	BrightEye 2.0.7

•	 	Blackmagic Design 
UltraScope 1.5

•	 	Final Cut Server 

•	 	FileZilla

•	 	Microsoft Office 

•	 	Stickies 7.0

PERIPHERIAL EQUIPMENT

•	 	Samsung VHS/DVD 
Recorder DVD-VR375

•	 	JVC VHS/DVD Recorder  
SR-MV45U

•	 	BrightEye 3 Analog to SDI 
Converter TBC/FS

•	 	Blackmagic Design 
Ultrascope
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CTDA WORKSTATION HARDWARE/SOFTWARE FUNCTIONS

We’ve included these points to show what each device is used for. 

You do not need the exact models to perform our procedures, but they 

should be able to do roughly the same thing listed below each device.

SAMSUNG VHS/DVD RECORDER DVD-VR375

•	 	Main player for VHS cassettes 

•	 	Sends an analog (Composite-Y) signal to the BrightEye 3 

•	 	Displays a timecode on the front of the machine 

•	 	Remote control allows you to navigate through the cassette with 
the conventional Rewind, Fast Forward, and Play buttons

JVC VHS/DVD RECORDER SR-MV45U

•	 	Sends a reference “black” signal to the BE 3 Converter

•	 	Acts as a backup system in case the Samsung malfunctions

BRIGHTEYE 3 ANALOG TO SDI CONVERTER TBC/FS

•	 	Time Base Corrector/Frame Synchronizer with Composite, 
Component and Y/C inputs 

•	 	Receives the analog signal from the VCR, passes the signal 
through TBC/Frame Sync, and sends it out as a digital SDI signal 
to the UltraScope Card

•	 	Adjust any imperfections in video quality, including chroma, 
brightness (IRE), and frame sync

BLACKMAGIC DESIGN ULTRASCOPE

•	 	A combination PCI Express card and software package designed 
to work with a PC and display

•	 	Receives the SDI signal from the BrightEye 3 Converter

•	 	Displays a waveform, histogram, vector scope, audio, and 
preview monitor of the video for image monitoring

BLACKMAGIC DESIGN DECKLINK

•	 	PCI Express card that receives analog and SDI audio/video 
signals

•	 	The audio from the Samsung VHS player connects to the 
breakout XLR cables of the Decklink

•	 	The video from the UltraScope’s SDI Out is sent to the SDI In of 
the Decklink

Samsung VHS/DVD Recorder  
DVD-VR375

JVC VHS/DVD Recorder SR-MV45U

BrightEye 3 Analog to SDI Converter 
TBC/FS

Blackmagic Design Ultrascope

Blackmagic Design Decklink
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INITIAL SETUP

Before you begin, you will have to setup your computer. Once you 

have installed the cards into the computer and connected the peripherial 

machines together, make sure your Macintosh workstation is up-to-date 

with the latest software and drivers. Below are our recommended settings 

for the computer (hard drives and storage) and relevant software. 

It is equally important to setup a file naming scheme. We have 

included ours as a guideline. However, if you have your own, be sure to 

incorporate it within your video workflow.

COMPUTER SETTINGS
The workstation is set up to use three of its four hard drives in a striped 

RAID array, in order to achieve the necessary write speeds to capture HD 

video in real-time. The RAID was set up using the OS’s native Disk Utility. All 

OS files and application software are then installed on the primary system 

drive, so that the RAID array can be kept available for captured footage only.

With the captured footage stored on the RAID array, we decided to 

store the finalized files on the desktop. We seperated our output based on 

the file type. The following folders were created on the desktop:

•	 	01 QT Reference Files

•	 	02 Compressor Output

SOFTWARE SETTINGS

To make the most of our computers, we setup a cluster to use in  

Compressor (part of Final Cut Studio). This setup allows the computer to 

use as much of the processing power as possible. You will only have to do 

this once; after that, you just tell Compressor to use the cluster you set up.

It is best to create the derivative settings ahead of time as well. Our 

recommendations are included, but they may be tweaked a bit in the future, 

so check back for updates in later versions.

With regards to Final Cut Pro, create the settings for capturing from 

your VHS peripherials. The settings included are specific to our hardware.
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Compressor
Compressor is set up using the Qmaster Preferences Pane to make 

use of all 8 processing cores when encoding video. It is necessary to select 

the appropriate cluster from the drop-down menu in the “Submit Job” dialog 

box.

How to Create a Cluster

1. Find out how many processing threads your computer has:

a. Go to Applications > Utilities > Activity Monitor

b. Go to Window > CPU Usage

c. The number of vertical bars represents the number of processing 
threads.

2. Setup Qmaster

a. Go to Apple > System Preferences

b. Click on Apple Qmaster and click OK to reopen System 
Preferences

c. On the Setup tab:

i. Share this computer as: Services and cluster controller

ii. Uncheck Share and Managed options for Rendering

iii. Check both Share and Managed options for Compressor

iv. Click on Options for selected service...

v. Enter the total number of processing threads minus one. 
For example, we have 16 threads, so we have a total of 15 
instances.

vi. Identify this QuickCluster as: [Enter your name here. It can be 
anything that identifies this computer.]

d. On the Advanced tab:

i. Check the box to Restart all Services every 24 hours.

ii. Uncheck the box to Allow discovery via Bonjour.

iii. Identify this computer to Qadministrator as: [Enter your name 
here. It can be anything that identifies this computer.]

3. Click the lock to prevent further changes.

Our computer has 16 processing threads.
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Apple Qmaster 
(32-bit) pane - Setup 
tab with settings 
for our Evangelion 
computer.

Apple Qmaster (32-
bit) pane - Advanced 
tab with settings 
for our Evangelion 
computer.
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How to Create Derivative File Settings (Compressor)

1. Open Compressor.

2. In the Settings window, on the Settings tab, click on the “Create a new setting group” 
button.

3. Under the Custom folder, select the Untitled folder.

4. In the Inspector window, change the name of the folder to the project title or any 
other name that will make sense to you. Press Enter to save settings.

In order to create each setting, it is best to start with a template. Templates are in the top 

Apple folder. For each setting here, the template that was started with is listed. Select it then 

click on the “Duplicate Selected Setting” button. The presentation files have separate SD and 

HD settings due to frame size.

Archival MP4 file

1. Template: Apple > Formats > 
QuickTime > QuickTime H.264

a. Name: 01 DPL Archive File

b. Description: H.264 video with 
stereo AAC audio. Settings based 
off the source resolution and 
frame-rate.

2. Encoder Tab

a. Format: QuickTime Movie

b. Extension: mp4

c. [Checked] Allow Job Segmenting

d. Video: Settings: (enabled)

  ▪ Compression Type: H.264

  ▪ Frame Rate: Current

  ▪ Key Frames: Automatic

  ▪ [Checked] Frame Reordering

  ▪ Data Rate: Automatic

  ▪ Quality: Best

  ▪ Encoding: Best quality (multi-
pass)

e. Audio: Settings: (enabled)

  ▪ Format: AAC

  ▪ Channels: Stereo (L R)

  ▪ Rate: 48.000 kHz

  ▪ [Unchecked] Show Advanced 
Settings

  ▪ Render Settings: Quality: Better

  ▪ MPEG-4 AAC Encoder 
Settings: Target Bit Rate: 192 
kbps

f. Streaming: None

g. [Checked] Add clean aperature 
information

3. Frame Controls Tab: Frame Controls: 
Off (All options are inactive)

4. Filters Tab

a. Video: All unchecked

  ▪ Black: 0.0 / White: 0.0

b. Audio: All unchecked

  ▪ Soften Above: 15.0

  ▪ Noise Threshold: 100.00

  ▪ Master Gain: 0.0

c. Color: Default for Encoder

5. Geometry Tab

a. Source Inset (Cropping): Crop to: 
Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

b. Dimensions (encoded pixels): 100% 
of source

c. Output Image Inset (Padding): 
Padding: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None
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Presentation mp4 file for High Definition files

1. Template: Apple > Formats > 
QuickTime > QuickTime H.264

a. Name: 02 DPL Presentation File - 
Deinterlaced for Presentation File 
- HD

b. Description:  

2. Encoder Tab

a. Format: QuickTime Movie

b. Extension: mp4

c. [Checked] Allow Job Segmenting

d. Video: Settings: (enabled)

  ▪ Compression Type: H.264

  ▪ Frame Rate: Current

  ▪ Key Frames: Every 30 frames

  ▪ [Checked] Frame Reordering

  ▪ Data Rate: Restrict to 1500 
kbits/sec

  ▪ Optimized for: Download

  ▪ Quality: High

  ▪ Encoding: Best quality (multi-
pass)

e. Audio: Settings: (enabled)

  ▪ Format: AAC

  ▪ Channels: Stereo (L R)

  ▪ Rate: 44.100 kHz

  ▪ [Unchecked] Show Advanced 
Settings

  ▪ Render Settings: Quality: 
Normal

  ▪ MPEG-4 AAC Encoder 
Settings: Target Bit Rate: 128 
kbps

f. Streaming: None

g. [Checked] Add clean aperature 
information

3. Frame Controls Tab

a. Frame Controls: On

b. Resize Filter: Better (Linear Filter)

c. Output Fields: Progressive

d. Deinterlace: Better (Motion 
adaptive)

e. [Checked] Adaptive Details

f. Anti-alias: 0

g. Details Level: 0

h. Rate Conversion: Fast (Nearest 
frame)

i. Set Duration to: 100.000% of 
source

4. Filters Tab

a. Video: All unchecked

  ▪ Black: 0.0 / White: 0.0

b. Audio: All unchecked

  ▪ Soften Above: 15.0

  ▪ Noise Threshold: 100.00

  ▪ Master Gain: 0.0

c. Color: Default for Encoder

5. Geometry Tab

a. Crop to: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

b. Frame Size: 1280 x 720

c. Pixel Aspect: Default for Size

d. Padding: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None



14 Initial Setup

Presentation mp4 file for Standard Definition files

1. Template: Apple > Formats > 
QuickTime > QuickTime H.264

a. Name: 02 DPL Presentation File - 
Deinterlaced for Presentation File 
- SD

b. Description:  

2. Encoder Tab

a. Format: QuickTime Movie

b. Extension: mp4

c. [Checked] Allow Job Segmenting

d. Video: Settings: (enabled)

  ▪ Compression Type: H.264

  ▪ Frame Rate: Current

  ▪ Key Frames: Every 30 frames

  ▪ [Checked] Frame Reordering

  ▪ Data Rate: Restrict to 1500 
kbits/sec

  ▪ Optimized for: Download

  ▪ Quality: High

  ▪ Encoding: Best quality (multi-
pass)

e. Audio: Settings: (enabled)

  ▪ Format: AAC

  ▪ Channels: Stereo (L R)

  ▪ Rate: 44.100 kHz

  ▪ [Unchecked] Show Advanced 
Settings

  ▪ Render Settings: Quality: 
Normal

  ▪ MPEG-4 AAC Encoder 
Settings: Target Bit Rate: 128 
kbps

f. Streaming: None

g. [Checked] Add clean aperature 
information

3. Frame Controls Tab

a. Frame Controls: On

b. Resize Filter: Better (Linear Filter)

c. Output Fields: Progressive

d. Deinterlace: Better (Motion 
adaptive)

e. [Checked] Adaptive Details

f. Anti-alias: 0

g. Details Level: 0

h. Rate Conversion: Fast (Nearest 
frame)

i. Set Duration to: 100.000% of 
source

4. Filters Tab

a. Video: All unchecked

  ▪ Black: 0.0 / White: 0.0

b. Audio: All unchecked

  ▪ Soften Above: 15.0

  ▪ Noise Threshold: 100.00

  ▪ Master Gain: 0.0

c. Color: Default for Encoder

5. Geometry Tab

a. Crop to: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

b. Frame Size: 720 x 480

c. Pixel Aspect: Default for Size

d. Padding: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None



15Initial Setup

DVD - Video

1. Template:

a. Name: 03 DVD - Video

b. Description: Fits up to 90 minutes 
of video with Dolby Digital audio at 
192 Kbps or 60 minutes with AIFF 
audio on a DVD-5

2. Encoder Tab

a. Format: MPEG-2

b. Extension: m2v

c. [Checked] Allow Job Segmenting

d. Stream Usage: SD DVD

e. Video Format:All inactive

f. Quality:

  ▪ Mode: Two Pass VBR Best

  ▪ Average Bit Rate: 7.7 Mbps

  ▪ Maximum Bit Rate: 9.0 Mbps

  ▪ Motion Estimation: Best

g. GOP: All inactive

h. Extras: 

  ▪ [Checked] Add DVD Studio Pro 
metadataKey Frames: Every 30 
frames

  ▪ [Unchecked] Include Chapter 
Markers only

  ▪ [Unchecked] Multiplexed 
MPEG-1 / Layer 2 Audio

3. Frame Controls Tab: Frame Controls: 
Off (All options are inactive)

4. Filters Tab

a. Video: All unchecked

  ▪ Black: 0.0 / White: 0.0

b. Audio: inactive

c. Color: inactive

5. Geometry Tab

a. Crop to: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

b. Frame Size: inactive

c. Pixel Aspect: inactive

d. Padding: Custom

  ▪ Left: 0; Right 0; Top: 0; 
Bottom: 0

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None
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DVD - Audio

1. Template:

a. Name: 04 DVD - Audio

b. Description: Fits up to 90 minutes 
of video with Dolby Digital audio at 
192 Kbps or 60 minutes with AIFF 
audio on a DVD-5

2. Encoder Tab

a. File Format: Dolby Digital 
Professional

b. Extension: ac3

c. [Checked] Allow Job Segmenting

d. Audio

  ▪ Target System: DVD Video

  ▪ Audio Coding Mode: 2/0 (L, R)

  ▪ Sample Rate: 48 kHz

  ▪ Data Rate: 192 kbps

  ▪ Bit Stream Mode: Complete 
Main

  ▪ Dialog Normalization: -27dBFS

e. Bit Stream

  ▪ Dolby Surround Mode: Not 
Indicated

  ▪ [Checked] Copyright Exists

  ▪ [Checked] Content is Original

  ▪ [Unchecked[ Audio Production 
Information

  ▪ All else inactive

f. Preprocessing

  ▪ Compression Preset: Film 
Standard Compression

  ▪ General: [Unchecked] Digital 
Deemphasis

  ▪ Full Bandwidth Chan.:  
[Checked] Low-Pass Filter 
[Checked] DC Filter

3. Frame Controls Tab: Frame Controls: 
Off (All options are inactive)

4. Filters Tab

a. Video: inactive

b. Audio: All unchecked

  ▪ Soften Above: 15.0

  ▪ Noise Threshold: 100.00

  ▪ Master Gain: 0.0

c. Color: inactive

5. Geometry Tab

a. All options are inactive

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None
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MP3 File

1. Template:

a. Name: 05 DPL - Transcription MP3

b. Description: MP3 audio @ 192 kbps, 
with 44.8Khz, stereo

2. Encoder Tab

a. File Format: MP3

b. Extension: mp3

c. Stereo Bit Rate: 192 kbps

d. [Unchecked] Use Variable Bit Rate 
Encoding (VBR)

e. Sample Rate: 48.000 kHz

f. Channels: Stereo

g. [Checked] Joint Stereo

h. [Checked] Smart Encoding 
Adjustments

i. [Checked] Filter Frequencies Below 
10 Hz

3. Frame Controls Tab: Frame Controls: 
Off (All options are inactive)

4. Filters Tab

a. Video: inactive

b. Audio: All unchecked

  ▪ Soften Above: 15.0

  ▪ Noise Threshold: 100.00

  ▪ Master Gain: 0.0

c. Color: inactive

5. Geometry Tab

a. All options are inactive

6. Actions Tab

a. [Unchecked] Email Notification to:

b. [Unchecked] Execute Apple Script 
on outpost

c. Default Destination: None

How to Create the VHS Easy Setup (Final Cut Pro)

In Final Cut Pro, an Easy Setup is a collection of settings that determines what format you 

want to capture and edit. Ideally, once the Easy Setup is configured, you should not have to 

set it up again.  Below are the steps for the initial setup.

1. Open Final Cut Pro.

2. Click the Final Cut Pro drop-down menu on the top bar.

3. Click Audio/Video Settings… The Audio/Video Settings window will open.

4. Set the Sequence Preset to Uncompressed 10-bit NTSC 48 kHz.

  à This is the highest quality option for extracting footage from tapes, and it is the 
reason for large file sizes after capture.

5. Set the Capture Preset to Blackmagic NTSC – 10 bit.

  à This setting allows for capturing through the Blackmagic Decklink receiving the 
VHS signal.

6. Set the Device Control Preset to Blackmagic NTSC 29.97.

  à This setting tells FCP the video format and frame rate the VHS is sending.

7. Set the Video Playback to Blackmagic NTSC – 10 Bit (720 X 486).

  à This setting tells FCP what format to use in playing back the material on the FCP 
interface.

8. Set the Audio Playback to Blackmagic Audio.

  à This setting may be changed manually while editing.  The editor may choose 
to play back the audio through the Built-in Output (headphones) or the Display 
Audio (speakers under the MAC screen).

9. Click the Create Easy Setup… button.  
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10. A window will open to name the setup and give it a description.  
Type in the following:

  à Name: VHS Capture

  à Description:  Capturing video via the Blackmagic capture card 
from a VHS source.

  à Click the Create… button.  

  à The “VHS Capture” setup will now be placed in the list of Easy 
Setups found here: Final Cut Pro > Easy Setup > Use > VHS 
Capture.

Final Cut Pro Easy 
Setup window with 
settings used on our 
workstation.

Final Cut Pro Easy 
Setup window - 
assigning a name 
and description.
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FINAL CUT SERVER SETUP

For this first round of videos, we did not setup a “proper” workflow 

using the Final Cut Server. Instead, we used it as a place to store the videos 

so that our Content Specialists could view the videos outside of the video 

workstation. Otherwise, they would have to sit at the computer to watch 

the videos, which would have limited the amount of time the Digitization 

Specialists could use that workstation.

Final Cut Server was installed on a computer (standard installation) 

and does not have any customization placed on it. The only thing that we 

did was to make the computer accessible by Remote Desktop so that the 

Project Supervisor could access it and learn more about customizations. 

Once we have more information, we will add it here.

ARCHIVAL FILE NAMING
All digital files are named according to a standard file naming 

convention. Each file is assigned a unique filename, such as 

“chc99990000010001001.” Each filename consists of six component parts 

which help to identify and locate the file on the archive server:

1. Repository: cta00090000010001001

2. Collection: cta00090000010001001 

3. Object: cta00090000010001001

4. Sequence: cta00090000010001001

5. Detail: cta00090000010001001

6. Format: cta00090000010001001

Repository
The repository component indicates which Library repository the file 

is a part of, and serves as a top-level folder in the archive server directory 

structure.

•	 	Number of digits: 3 

•	 	Type: text

•	 	Example: cta00090000010001001

  à cta = Cuban Theater Digital Archive Repository
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Collection
A four-digit sequence identifying a larger collection of items, usually 

donated at the same time, or regarding the same thematic subject matter.

•	 	Number of digits: 4 

•	 	Type: numeric

•	 	Example: cta00090000010001001

  à 0009 = CTDA Productions

Object

A six-digit sequence assigned sequentially to each distinct bibliographic 

or intellectually discrete item. For example, a book might have many pages, 

but it is one object.

•	 	Number of digits: 6

•	 	Type: numeric

•	 	Example: cta00090000010001001

  à 000001 = First object in the collection. In this case, El Dragón 
de Oro Performance.

Sequence
A four-digit identifier assigned sequentially to each complete and 

distinct leaf, page, side, or view of an object. For example: object 1 

(asm0460000001) is a letter with four pages.  The first page would be 

assigned sequence number 1 (asm04600000010001…), the second page 

sequence 2 (asm04600000010002…), etc.

•	 	Number of digits: 4

•	 	Type: numeric

•	 	Example: cta00090000010001001

  à At this time, we have not had multiple sequences for any of our 
assets.

Detail
A two-digit number indicating a more specific view of a larger 

image. For example: Object 1 (chc5247000023) is a  one-page letter 

written by Jose Martí, and has a clear, hand-written signature in the lower 

left hand corner. The image for the object as a whole would be labeled 

“chc52470000230001001,” and a separate image for just the signature 

would be labeled “chc52470000230001011.” 

•	 	Number of digits: 2

•	 	Type: numeric

•	 	Example: cta00090000010001001

  à At this time, we have not had a detail for any of our assets.
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Format
A single digit number indicating a file format different from the archival 

standard for a given media type. For example: For a TIFF master image 

file (chc52470000230001001.tif), multiple derivatives can be made in a 

variety of file formats, such as JPEG (chc52470000230001002.jpg), PNG 

(chc52470000230001003.png), or in the case of digitally-born content, a 

format such as PSD or EPS (chc52470000230001004.psd).

•	 	Number of digits: 1

•	 	Type: numeric

•	 	Example: cta00090000010001001

  à The archival mp4 has format 1.

  à The presentation mp4 has format 2.

ARCHIVE SERVER

Once the archival master files have been created, quality-checked, 

and named appropriately, they are uploaded to the Library’s secure archival 

preservation file server via the FileZilla FTP client. 

With regards to the born-digital objects that were filmed by the CTDA 

graduate assistants, we store the original folders that were recorded to the 

hard drives/SD cards as they are onto the server. 
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CATALOGING & TRACKING

CREATE A STUB METADATA RECORD FOR LEGACY MATERIALS
When digitizing any VHS tapes, MiniDV tapes, DVDs, or other analog 

materials, create the stub record before beginning the digitization process. 

1. Log in to the CTDA Admin Database.

2. Click on “Create a Digital Object.”

3. Enter the required basic metadata:

a. Title: Insert the name of the play/event.

b. Collection: Select the event’s corresponding collection (Example: 
Teatro de la Luna, Déxter Cápiro, etc.).

c. Format: Insert the original format in which the media was 
captured (VHS, MiniDV, etc.).

d. In the Attention field, insert the capture notes taken while 
capturing the video.

4. Save the Stub Record.

CREATE A STUB METADATA RECORD FOR FILMED MATERIAL
When filming any new material for the archive, create the stub record 

before you go to the location to film.

1. Log in to the CTDA Admin Database.

2. Click on “Create a Digital Object.”

3. Enter the required basic metadata:

a. Title: Insert the name of the play/event

b. Collection: All material filmed by the CTDA goes under the 
collection “CTDA Productions”

c. Format: Digital Recording

4. Save the Stub Record.

5. After the recording, locate this stub record and add the production 
report information.

a. In the Attention field, insert the production report for play/events 
filmed by CTDA.

b. See the Filming Guidelines for an example of the production 
report.
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An example of a stub record from the CTDA database; database uses the Romeu 
system available at https://github.com/umdsp/romeu.

https://github.com/umdsp/romeu
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An example of a stub record from the CTDA database; database uses the Romeu 
system available at https://github.com/umdsp/romeu.

STICKIES

Stickies is a simple application in which general, freehand notes can 

be taken on size- and color-adjustable windows.  The CTDA editors chose 

to use Stickies to have a textual monitor for the statuses of videos going 

through the digitization workflow from capture to final file management.  

Using the digital object ID, editors can note when and where these files hop 

from one step to the next as the videos undergo processing,   

The database has a system for a queue, but we found that it was 

easier to have something on the computer to keep track of what was going 

on with each video. This was especially important as we developed the 

workflow and made changes along the way. We decided to test out the 

Apple Stickies software. Since there are only seven colors, we organized 

each step as follows:

https://github.com/umdsp/romeu


25Cataloging

•	 	PINK: PROCESSING (Steps 1, 2 & 3)

  à Creation of Stub Record & File Naming

  ▪ For Legacy Video:  Physical Assessment and Video Capture

  ▪ For Born-Digital Video:  File transferring from SD Cards to 
Hard Drive

•	 	YELLOW: EDITING (Steps 4, 5, & 6)

  à Editing video

  à Creation of Asset and QuickTime Reference File

  à Upload QuickTime Reference File that is then converted to a 
video file by the Final Cut Server.

•	 	GREEN: CONTENT QUALITY CONTROL (Steps 7 & 8)

  à Upload edited file to Final Cut Server

  à Await approval by the Content Specialist.

•	 	BLUE: DERIVATIVE CREATION (Step 9)

  à After approval by the Content Specialist, we use Compressor to 
create 5 archival derivatives for each asset. 

•	 	PURPLE: DERIVATIVE QUALITY CONTROL (Step 10)

  à Once all derivatives have been created, they need to be Quality 
Controlled before being uploaded to the archive.

•	 	GRAY: FINAL FILE MANAGEMENT (Steps 10 - 14)

  à Upload all derivatives to the Archive Server

  à Delete Files from Final Cut Server

  à Delete the QuickTime Reference File

  à Delete all 5 archival derivatives

  à Delete Final Cut Project Files

  à Delete Capture Scratch folder files related to the project

We have also tried out using an Excel file to keep track of our steps. A 

version of that file can be found on the website.

Our workflow is organized by multiple steps so that all of the material can be monitored efficiently. Each step is 
represented by a Sticky Note using the Macintosh Software “Stickies”. 
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DIGITIZING LEGACY MATERIALS

The CTDA Workstation uses a variety of software and hardware to 

ensure the purest, most lossless digitization possible for its archival material.  

This equipment includes the Samsung VCR, the BrightEye 3 Analog to SDI 

Converter with TBC (Time Base Corrector) and Frame Sync, the Blackmagic 

Design Decklink, and the Blackmagic Design UltraScope.

HARDWARE PROCEDURES

1. Check ALL Connections

a. Power Supplies of VCR’s and the BE 3.

b. Composite Y Video (BNC):

  ▪ Samsung VCR A/V Out (Yellow) - BE 3 Cpst. Y In

c. Composite Y Video (BNC):

  ▪ JVC VCR  DVD Output (Yellow) – BE 3 Ref In

d. SDI Video (BNC):

  ▪ BE 3 SDI Out – UltraScope SDI In

e. SDI Video (BNC):

  ▪ UltraScope SDI Out – Decklink SDI In

f. Analog Audio (RCA-XLR):

  ▪ Samsung VCR A/V Out (White) – Decklink (breakout cable) 
AUDIO IN LEFT

g. Analog Audio (RCA-XLR): 

  ▪ Samsung VCR A/V Out (Red) – Decklink (breakout cable)  
AUDIO IN RIGHT

2. Turn On Samsung VCR.

3. Turn On JVC VCR.

4. Check A/V In/Out Settings on Mac

a. Launch System Preferences > “Other” menu, Click Blackmagic 
Design.

b. Set input to “SDI Video & Analog XLR Audio”.
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SOFTWARE PROCEDURES

1. Launch applications BrightEye Mac, UltraScope, and Final Cut Pro.

2. In BrightEye Mac, Click “Rebuild List” to refresh the signal read by 
the BE 3.

3. In UltraScope, Click “SDI” and “COLOR” in the video window.

Final Cut Pro Procedures

1. Open Final Cut Pro. 

2. Save the Project:

a. Navigate to File > New Project.  

b. Save the project: Go to File > Save Project As. 

c. Navigate to the Documents > Final Cut Pro Documents > ctda 
folder. 

d. File Name = Object ID (Acquire from Stub Records, i.e. 
cta00120000340001001...TitleOfPlay). 

e. Click Save. 

3. Select the proper settings for capturing VHS: 

a. Go to Final Cut Pro > Easy Setup. 

b. Format: all formats 

c. Rate: all rates 

d. Use: VHS Capture 

e. Click Setup. 

4. Setup the capture: 

a. Press Command+8 to open the Log and Capture window. A 
signal from the VCR should appear in the left-hand Preview 
monitor.

b. Under the Logging tab, enter the Object ID into the Description 
field.  This ID will be given to the capture file once the capture 
process is finalized.  If this field is left blank, FCP will automatically 
title the capture file “Untitled”.

c. Navigate to the Clip Settings tab and check the Preview box so 
that one can monitor audio during the capture (FCP’s default 
leaves this unchecked).

d. Navigate to the Capture Settings tab and make sure that all four 
capture/render fields, the Caches, and the Autosave Vault are 
set to “RAID Capture Array:Final Cut Pro Documents”.  Once set, 
these settings will never change unless manually altered.  If they 
are correct, do not change anything and Click Cancel.

Once these 
programs are 
opened, you 
can navigate 

quickly 
between these 

applications 
using 

Cmd+Tab.
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BE3 and UltraScope Procedures
BrightEye and Ultrascope work together to allow for the highest quality 

capture from the VCR in terms of brightness, color, and frame sync. The 

BE3 automatically synchronizes frames, so the adjustments made will be 

for brightness and color. In professional recordings, standard SMPTE color 

bars are provided at the beginning of the tape to help adjust the video signal 

to its best potential video quality upon transfer to digital. In most cases, 

however, these plays do not have such bars, so one must make adjustments 

according to the visuals of the play.

Important Note:  Make sure this judgment is more technical and less 

subjective.  That is, the color deficiency in question may be lighting design 

created by the director that was simply misread by the editor. 

1. Many plays begin with a dark lighting cue, so fast forward the VHS 
cassette to a location on the tape where the lighting on the set 
seems to be the average brightness of the show.  Press Play and let 
the tape roll as you work.

2. UltraScope: Enter Full Screen Mode by clicking Command+F.

3. As the video plays, notice the top-center Waveform Monitor.  

a. This monitor reads the screen from left to right for blacks and 
whites in a diagram where dark tone waves appear on the 
bottom of the scope, and brighter tones appear higher in the 
scope.  Brightness waves are measured in IRE units (numbers 
on the right of the scale).  Each horizontal line is separated by 
roughly 15 ire.

i. Example #1: A black curtain with general light hitting it should 
show waves very low on the diagram, maybe near 15 ire.  
Though its color is black, only true black, with no detail should 
be near 0 ire.

ii. Example #2: An actor’s bright white shirt on the right side of 
the frame will appear as a high wave peak on the right side of 
the Waveform monitor, maybe near 90 ire.  A peak that passes 
100 ire will be too bright to deliver any information, thus if the 
shirt’s wave goes above 100 ire, details like ripples or buttons 
will be lost in bright white.

b. Black: 7.5 ire – no detail, the blackest part of the frame.

c. Pedestal: 3.5 ire – lowest level of the waveform, where the signal 
“sits”.

d. White: 100 ire – no detail, like the whites in highlights and 
metallic glints.

e. Flesh tones: approx. 80 ire – for Caucasians.
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4. Adjust Pedestal: Often VHS cassettes display blacks darker than the 
look of the actual play.  For this reason, we must adjust the Pedestal, 
which moves the entire waveform signal higher or lower on the 
scale.  We will move it higher so no detail is lost in the darkness.

a. BE3:  Click on the Proc tab.

b. Click Default on all four adjustment lines.

c. UltraScope:  Notice the Pedestal, where the signal “sits”.

d. BE3:  On the Pedestal line, Click the UP arrow several times until 
the Pedestal level on the waveform monitor reaches 3.5 ire.

e. UltraScope:  View the preview monitor displaying the video 
signal, and analyze the blacks in the frame.  Make sure that the 
really dark tones still have definition.  

i. Example: a dark set piece in the background (in light) should 
not seem like a curtain, but any details on it should be 
apparent, in context, of course, with the lighting design of the 
scene.  

ii. Important Note:  One should not raise the pedestal so high 
that tones that supposed to look black begin to look gray.  
Raising the pedestal causes all tones on the gray scale to lose 
some degree of contrast.  Get black detail, but no contrast 
leaves an ugly trail. 

5. Adjust Gain:  Raising the Pedestal may cause the lighter tones to go 
over 100 ire, a degree that only highlights and glints should reach.  
The Gain adjustment allows one to “squeeze” or “expand” the 
waveform signal without affecting the position of the pedestal.  

a. BE3:  Under the Proc tab, on the Gain line, click the UP or DOWN 
arrows repeatedly until the peaks of the waveform only barely 
reach the 100 ire line.

b. UltraScope:  Check the preview monitor.  If the image looks like 
the whites and lighter tones are blown out and have lost detail, 
decrease the Gain to a point where there is enough detail in 
the lighter tones and the image looks well balanced in terms of 
brightness and contrast.

6. Adjust Hue:  Again, all of these adjustments are best calibrated when 
SMPTE color bars are provided on the tape, but in most cases, that 
luxury is not present.  At times, VHS recordings will display in a 
deficient or altered color.  The Hue adjustment line allows for one 
to shift the Hue, or color temperature, to a color setting that looks 
closest to what the audience experienced.

a. The best place to adjust Hue is while monitoring a scene lit by 
general white stage lighting, no color.

b. BE3:  Under the Proc tab, on the Hue line, click the UP or DOWN 
arrows repeatedly until the color looks correct.

i. Check flesh tones whenever possible.



30 Digitizing Legacy Materials

ii. Check white objects – if they supposed to be white and they 
are not, adjust the hue to where it looks the whitest.

iii. Check black objects – if the blacks look like they have a color 
tint, adjust the hue to where they look black.

7. Adjust Chroma:  Sometimes video signals from VHS tapes look 
de-saturated or oversaturated.  In a de-saturated image, flesh tones 
look pale, or grayish.  In an oversaturated image, flesh tones look 
red, and lose detail.  The Chroma adjustment line will allow one to 
increase or decrease the Chroma (or saturation) level of the signal.

a. Important Note: Chroma should be the last step for video signal 
adjustment.  DO NOT calibrate the Chroma level until settings for 
the Pedestal, Gain, and Hue have been adjusted.

b. BE3:  Under the Proc tab, on the Chroma line, click the UP or 
DOWN arrows repeatedly until the saturation level looks correct.

i. Check flesh tones whenever possible.

ii. Check detail in clothing and solid-colored pieces.

Troubleshooting the BE3
Sometimes the BE3 does not respond, does not allow adjustments 

under the Proc tab, or does not read the video signal.  Try the following in 

order:

1. Click Rebuild List on the top-left of the window to refresh the signal.

2. Restart the application.

3. Unplug the power supply of the BE3 and wait 10 seconds before 
reconnecting.  Once plugged in, the BE3 will automatically refresh. 

Taking Notes During Capture

Before clicking “Capture Now” on Final Cut Pro, set up a Word 

document for taking notes on the video while the capture is in progress.

1. Open Microsoft Word, navigate to File > Save As…> and name 
the document the same name given to the FCP project file (i.e. 
cta00120000340001001...TitleOfPlay). 

2. Use the data from the CTDA Stub Record and/or any titles/credits 
on the VHS recording that give information relevant to the Capture 
Notes fields.

3. Use the Resizing Tool on the bottom-right corner of the Document 
Window to decrease the size of the window, so that you can take 
notes while watching Final Cut Pro’s Capture Window.

4. Use the Tape Time code displayed on the front of the VCR for 
marking the placement of these notes.
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5. What is noteworthy?

a. When titles begin to appear.

b. When the play actually begins and ends on the tape.

c. When an introduction, if any, by a director or other is given.

d. When there is any form of video skipping, blipping, staggering, 
color defect, white noise, static, sound defect, operator error, or 
any other technical deficiency in the capture that is prominent.

e. Solutions for any of the video problems, though many times, the 
deficiencies are permanent and irreparable.

6. When the capture is finished, make sure to Save the document.

Start the Capture

1. Return to the Logging tab. ONCE ALL ABOVE PROCEDURES ARE 
SET, CLICK Capture NOW on the bottom right of the window.  
A window will appear that below may briefly read “Locating 
Timecode”, and then “Capturing Clip”.

2. Press “Play” on the VHS Player to begin playing the tape.

3. When the Capture has reached the end of the play, Press ESC 
on the keyboard.  The captured video will appear as a clip in the 
Browser window.

Troubleshooting Final Cut Pro

There have been instances when Final Cut Pro fails to commence the 

Capture process or “unexpectedly quits” during the capture.  The following 

were successful solutions to these errors.

1. Check the available Disk Space of the Scratch Disks storing the 
Capture File. These uncompressed captures will generate large 
files considering the average Cuban play is over an hour.  If there is 
not enough disk space, consult the Supervisor for a cleaning of the 
drives and/or a temporary capture to the Startup Disk, instead of the 
RAID.

2. Make sure the name given to the capture in the Description field 
is not being used by another file on the computer.  This will cause 
Final Cut Pro to quit.

Once the video has been captured, the video needs to be edited into a 

form that can be approved. Skip to the section titled “Creating a Draft File for 

Quality Control.”
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DIGITIZING FILMED MATERIALS

We chose to go with Final Cut Pro for our video editing because it 

was the program that our graduate assistants were familiar with. However, 

the video files from the cameras are in an .MTS format, and Final Cut Pro 

has caused errors when importing this type of video. We are currently 

researching into using Adobe Premiere in our workflow. As we get more 

familiar with it, we will add our knowledge here.

COPYING FILES TO THE COMPUTER & ARCHIVE
After a specific event has been filmed, all of the raw footage must be 

transferred to both the computer used for editing and archived to the server 

to store all the files from that event (anything from the cameras, field mixer, 

or audio recording devices.

To transfer the materials from the cards into the storage media, take 

out the SD Card/s that contain the material you would like to transfer and:

1. Connect the Lexar Memory Card Reader to the Computer via a USB 
cable

2. Connect the SD Card to the SD Card slot on the Lexar Memory 
Card Reader

3. An icon named “NO NAME” will appear on your desktop. Double-
click this icon.

4. A new finder window will appear with two folders: “AVF_INFO” and 
“PRIVATE”.

5. Highlight both folders, drag and drop them into the computer disk 
directory you already created for the event (Documents > CTDA 
Documents > NEED TO ARCHIVE – TBA > RAW Files > Name of 
Event/Play + Date)

6. Once you are sure you have saved the material into the computer, 
you may format the SD card and place it in its corresponding 
Camera Kit
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Note: The 
camera operator 

and specs 
should be 

specified on 
the production 
report, so there 

is no need to 
specify those 
on the logged 

material.

USING FINAL CUT PRO TO ORGANIZE THE MATERIAL

Before transferring all of the material, we need to organize the 

workflow within the Final Cut Pro Project.  Here is how the material will be 

kept organized within the system:

1. Open a new project in Final Cut Pro.

2. Create a Bin and label it Raw Footage. (Shortcut to create a Bin is 
Command + B). This is where all of the raw, unedited material will 
be placed and located.

3. Create a Bin and label it Sequences. This is where all of the edited 
material will be placed and located.

4. If audio was recorded separately, create another Bin and label it 
Audio Files. This is where all of the audio files will be placed and 
located.

5. Now Save your project. Go to File > Save Project As and navigate 
to the Documents > Final Cut Pro Documents > ctda Folder. Name 
your project according to the settings specified by the CTDA DB. If 
no settings have been specified yet, name it the same as the name 
of the play and the date it was recorded. Click Save.

If the play was filmed with 2 cameras, make sure you log each set of 

media in order, the material from one camera first and then the material 

from the other camera. That way, we can keep all of the material organized 

and make the logging and editing process run more effectively.

In Final Cut Pro:

1. Go to File > Log and Transfer (Shift + Command + 8).

2. The Log and Transfer window will appear on the screen and you will 
see a list of the clips that are in the hard drive. Select the clips you 
would like to transfer (Shift + Click if selecting multiples clips). On 
the window on the right side, make sure you log the material and 
be as specific as possible. Here are some suggestions on how to log 
the material:

a. Name of the Play/Event

b. Camera on which the play was filmed (Camera 1 = C1 and 
Camera 2 = C2)

c. Date and Time

3. Once you have selected a clip to transfer (the clip will be 
highlighted), click Add Selection to Queue and the transferring 
process will begin.  While the material is transferring you can 
continue to log other clips and add them to the queue.

4. Once all of the media is transferred, go to your Final Cut Pro Project 
and organize your files by placing them into their corresponding 
bins.
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EDITING GUIDELINES

At the commencement of the CTDA project, motion pictures graduate 

students were hired to film local Cuban plays for the archive. Consequently, 

the coverage of the first performances included many close-up shots, 

stylistic zooms, and artistic follows of movements of the actors. As beautiful 

as the footage looked, it was apparent that the plays were being shot and 

edited in a cinematic style, focusing on the most interesting parts of the 

plays (i.e. emphasis on the better actor, close-ups on only the feet of a 

dancer, etc.). After various discussions, we concluded that filming and 

editing by the CTDA should take on an archival style, in which all elements 

of the play—visual aspects, rhythm, and performance styles—are preserved.

We’ve included this information in both guidelines because this was 

the biggest take-away from the project. Filming and editing from an archival 

perspective is greatly different from a promotional perspective.

Justifying the Cut
There are many reasons to cut a clip.  However, at the moment of 

a cut, the editor alters the experience of viewing the play in one form 

or another. The editor’s objective is to edit together two or more angles 

of coverage in such a way that the viewer experiences as close to a 

performance as the live presentation, while building an archival piece of 

Cuban theater.

An editor should use the cut…

1. When the emotion of the scene is better read from a different angle.

2. When the story or blocking is better seen from a wider shot or a 
different angle.

3. To emphasize the rhythm of the scene.

4. To divide a series of actions (when it seems beneficial to the 
experience).

5. To help distinguish a character’s multiple roles.

6. To emphasize an act or scene change.

7. To conceal an error in filming. 

8. To edit out pre-performance, intermission, and post-performance
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Catch the Emotion
If an actor begins to cry in a scene, for example, but his back is to 

the camera, the emotion may be better appreciated from another angle 

where his face is shown.  Capturing emotion, however, often requires 

a combination of the reactions from different actors. Note: This is not a 

judgment call on level of performance.  Whether the acting is poor or 

exceptional, the capturing of emotion in the scene takes utmost importance 

in editing.

Best Angle for the Action

Most of the plays we have filmed consist of four actors or less.  

Though this is a relatively small cast, directors do not design blocking for a 

couple of cameras but for an audience of many.  Thus, unlike an audience 

member in a limited seating position, the editor should edit with the goal 

that the viewer always has the best seat in the house.  As actors move in the 

space, the editor should continuously cut in favor of displaying the angles 

that deliver the most descriptive actions of the actors.  For instance, if two 

actors stand face to face in the center of the stage, their profile toward the 

audience, and suddenly one actor gives his back to the other actor, where 

should one cut?  A good cut would be to the angle in which both actors’ 

faces are seen.

On the same note, actors’ actions do not always take place in close 

proximity to each other and display of the set design is limited in the close-

up shot. The wide shot is essential for the archive. It is the shot that does not 

lose any part of the story. As seen below, it should be the most frequently 

used shot by the editor.

Final Cut Pro timeline of an edited video. The brown line is the wide shot of the play. 
The blue squares above it are close-up shots of the play. The most frequently used shot 
by the editor is the wide shot.
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Emphasizing Rhythm
An editor is not only responsible for preserving the actors’ movements, 

set and light design and the dialog but also the rhythm of scenes in 

particular and of the play as a whole. When an editor makes a cut, he or 

she either contributes to or inhibits the rhythm of the scene. One can feel a 

back-and-forth rhythm in the dialog between actors. Tension rises and falls.  

An increase in cuts often times speeds up the pace of the performance and 

requires the actors to have a faster rhythm. If the rhythm of the scene seems 

like it is lagging behind the pace of the cuts, use fewer cuts between angles. 

Fewer cuts allow for tension to simmer between actors. Often times, a cut 

that is perfect for rhythm can lose its perfection by a matter of frames. Cut 

and play back often to ensure the play’s rhythm is coming across.

During scenes with music, the cut has the power to accelerate the 

rhythm of the performance or act as a speed bump. Use the beat of the 

music to drive the edits.  

Consider cross dissolves with these segments, as this transition blends 

clips well with music. Coverage should flow seamlessly if edited according 

to rhythm. 

In the above example, you can see that the editor cut a gesture sequence into separate 
units of intention. Editor should never break unit of intention because it can cause a jarring 
effect that was not necessarily experienced by the audience.
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Dividing a Series of Actions
A cut has the power to enhance the choreography of an actor.  In the 

2011 recording of Obba, there was a scene in which an actress was seated 

on the stage floor performing a variety of slow movements with props, all 

in specific choreography.  The editor emphasized the choreography by 

cutting to different angles (that served the action) upon her transitions to the 

movements.  The result seemed like a seamless collage of choreography 

strung together in a way that the viewer can appreciate. Note: You should 

try to avoid cutting in between a gesture, movement or verbal sequence.

One Actor, Multiple Characters

Often we will film a one-actor performance of a play that involves 

multiple characters. In these cases, editing is essential to the reception 

of the story. As these actors jump from one character to the next, it is 

important for the editor to add cuts dividing the personalities into separate 

camera angles. A good example of this is the edit for the 2011 recording of  

Galeano 108’s Elektra.  

Scene Changes

An element of theater that often requires cuts is the transition between 

scenes.  These scene changes are commonly accompanied with light cues.  

The cross dissolve is the best tool to use for these transitions when they 

connote a passage of time.  However, scene changes vary in speed and do 

not always use light.  In these cases, a straight cut to the actors of the new 

scene, if they are different, may suit the transition best.

Concealing Errors

Sometimes a camera operator will make an error that draws too much 

attention to itself and distracts from the viewing of the play, such as an 

abrupt pan, tilt, or zoom. In the event that one must cover a mistake, do 

not assume that at the start of the mistake is by default where one should 

insert another camera angle. The editor should choose a point before the 

mistake where a cut can be justified, such as a cut that emphasizes rhythm 

or divides an action.
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Editing pre-performance, intermission, and post-performance
The editor is only allowed to cut out clips with the approval of the 

Content Specialist.

The Dissolve Transition
The cross dissolve video transition innately carries meaning.  It often 

implies a passage of time, but it can also saturate the emotion of a scene.  It 

is best used in slow, emotion-driven scenes, musical segments, and scene 

changes.  

 The length of the cross dissolve can give different meaning to the 

transition, and in turn, the scene. Similar to the cut, a fast dissolve will expect 

an accelerated performance from the actors, and vice versa. Beware of 

the temptation to place dissolves over several cuts. Though, visually, the 

transition blends clips safely, dissolves can jeopardize the rhythm of a scene.  

If used incorrectly, a cross dissolve can alter the director’s intention for the 

scene.  

Things NOT to Do

1. DO NOT use a cross dissolve transition for every cut.  As explained 
above, dissolves imply a passage of time, which only occasionally 
happens in a play.  Moreover, dissolves slow down the rhythm of 
the play.  It should not be the default solution for a questionable cut. 

2. DO NOT cut out clips from a recording.  Regardless if there is dead 
space, a mistake in the production, or a questionable performance, 
as archivists, we are to preserve not only the visual essence of the 
play but its duration and integrity as well.  

Color Correction
Color correction should not have to be done unless something went 

wrong with the setup of the camera(s). However, if it must be done, be sure 

to take into consideration the original lighting of the play. Drastic changes 

should not be made. If filmed with two cameras, with one being correctly 

calibrated, you can make the changes the color based on the correct 

camera recording.

Audio Editing
Editing audio levels can vary in difficulty, depending on the quality 

of sound recorded at the production. Our production team records audio 
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on various microphones, but the primary devices are the three Audio-

Technica boundary microphones. These microphones are placed at stage 

right, left and center along the apron (edge of stage). They are the closest 

microphones to the actors and are designed for such performances. One 

major difference with the boundary microphones is that, whereas the other 

microphones are recorded directly to the camera and attached to the 

video (called the Scratch track), the boundary microphones are recorded 

separately into our Tascam field mixer.  This means they will need to be 

synchronized before editing. See Appendix B: Boundary Microphones for 

more information.

Lessons Learned in the Editing Room
On one of our first local recordings, we attempted to film a play 

with a three-camera setup…with only two cameras. How? Since the show 

was running all weekend, the idea was that we would record the medium 

shots from the sides on the first night, and then just record a central wide 

shot with one camera on the second night.  Well, all the recordings were 

well executed, but there was one problem – actors are not robots!  In the 

editing room, we realized blocking, the choreographed movement of the 

actors across the space, was not the same on every line, the jokes were not 

received the same by the audience, and dialogue was changed occasionally.  

This made it a nightmare to edit, but it taught us three great lessons: 

1. There are no “do-overs” in filming theater; you have one shot to 
record the show well.

2. Whenever possible, avoid recording two or more performances of a 
play with the intention of editing them all into one piece.

3. A third camera may enhance the quality of the recording and ease 
of editing out mistakes.
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CREATING A DRAFT FOR QUALITY CONTROL

When the video has been edited to specifications, whether it is just 

making sure the legacy materials have the best capture possible or an entire 

two camera production been edited together, a draft file must be created 

for the content specialist to approve.

TITLE CARDS
Other than having all of the archival material be identified in the 

database, it is important that the most important information about a video 

is also contained in the video itself.  This allows for all references to be clear 

and directly related to the work at hand. We have a series of steps that we 

follow so that the information in each video is presented in a consistent 

manner.

Each video will have its own set of Title Cards for the Introduction 

and End Credits, presented in both English and Spanish. The information 

for these title cards depends on the video; however, below we have 2 

basic lists of things that need to be included: 1) Title Card information for 

legacy materials captured by the CTDA, and 2) Title Card information for 

productions filmed by the CTDA.  

Information for Legacy Video

1. Introduction

a. Cuban Theater Digital Archive Logo

b. Name of Theater Company presents / presenta

c. Name of the Play by / de Name of Playwright

d. Director – Name of Director

e. Date, Event (If applicable) Location

2. End Credits

a. Actors  / Actores

b. Director – Name of Director

c. Filmed by / Grabado por Name of Videographer
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d. Edited by / Editado por Name of Editor  
Note: Filmed and Edited by / Grabado y Editado por – If the same 
people did both things, insert only one title card

e. For more information about this production, please visit: www.
cubantheater.org

f. Para más información acerca de esta producción favor visitar: 
www.teatrocubano.org

g. Cuban Theater Digital Archive Logo and Copyright information

Information for Productions Filmed 

1. Introduction

a. Cuban Theater Digital Archive Logo

b. Cuban Theater Digital Archive and Name of Theater Company 
present / presentan

c. Name of the Play by / de Name of Playwright

d. Director – Name of Director

e. Date, Event (If applicable) Location

2. End Credits

a. Actors  / Actores

b. Director – Name of Director

c. Filmed by / Grabado por Name of Videographer

d. Edited by / Editado por Name of Editor 
Note: Filmed and Edited by / Grabado y Editado por – If the same 
people did both things, insert only one title card

e. For more information about this production, please visit: www.
cubantheater.org

f. Para más información acerca de esta producción favor visitar: 
www.teatrocubano.org

g. Cuban Theater Digital Archive Logo and Copyright information

You will find the information you need to include in each video in the 

corresponding digital object section in the CTDA Database.
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Adding the Title Cards to the Video Project
Once a video has been captured or imported into the Final Cut Pro 

Project:

1. Open the Final Cut Project named Title Cards

2. Once the project is open, with the sequence selected in the project 
window, copy (Command + C) the template for the title card 
sequences you need (Title Card Intro 4:3 and Title Card End Credits 
4:3 for Digitized material and Title Card Intro 16:9 and Title Card 
End Credits 16:9 for Filmed material)

3. Open the Final Cut Project for the video you want to add the Title 
Cards

4. Paste (Command + V) the Title Card sequences you copied from 
the template FCP project into your video project

Once each Title Card sequence is inside its corresponding project it is 

ready to be edited.

1. Double-click on the Title Card Intro or Title Card End Credits 
sequence to open it

2. To edit the information in the sequence, double-click on each 
section in the timeline

3. The Controls Panel (Located in the Viewer Window right above 
the timeline) will open. Edit the information for each section in the 
timeline (Note: All text should be in the font named Spysoclassic)

 Repeat this step for all information in both the Intro and End Credits 

sequences for your project.

Adding the Title Cards to the Project Sequence
When you are finished editing the information for the title cards:

1. Highlight the Intro sequence located in the Project Window and 
drag and drop it into the beginning of your timeline

2. Highlight the End Credits sequence located in the Project Window 
and drag and drop it into the end of your timeline

To make sure everything is correct and plays appropriately, make sure 

to watch your Title Cards play in the final project sequence.

When you have finished adding the title cards, your video is ready for 

export. 
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EXPORT THE MATERIAL FROM FINAL CUT PRO

Once your project has been edited and finished it needs to be 

exported into a QuickTime movie that will be uploaded to the Final Cut 

Server.  

1. Create the QuickTime Reference File:

a. Select the Sequence.

b. Go to File > Export > QuickTime Movie.

c. Navigate to the Desktop > 01 QT Reference Files folder.

d. File Name = Object ID.

e. Uncheck the box next to Make Movie Self-Contained.

f. Click Save.

UPLOAD MATERIAL TO FINAL CUT SERVER 

1. Open the Final Cut Server application and Log In.

2. Drag the QuickTime Reference File and drop it into the Assets 
window.

a. A window will appear asking you if you would like to flatten the 
video file.  Click Flatten.

b. The file will take several minutes to flatten. Once the flattening 
process is finished, the upload window will appear.

3. Enter the corresponding metadata.

a. In the “*Filename” section, insert the name of the play right next 
to its corresponding number (Example: cta00140000180001001- 
Teatro de Cuba)

b. In the Destination section, select “Media”

c. In the “*Title” section, insert the name of the play/event (Example: 
Teatro en Cuba)

d. You may insert a short description of the play/event and select 
keyword that may help people navigate to its location

e. In the “Status” section, select “Ready for Review”

f. Click Upload.

•	 	Note: The file will take some time to upload. Once it is finished it 
will appear in the Assets window.
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CONTENT SPECIALIST QUALITY CONTROL

The Content Specialist has the job of making sure the produced video 

is acceptable to be added to the CTDA collection. They log into the Final 

Cut Server to watch the video and ensure the following:

•	 	Digital record information needs to be checked to make sure that 
the filmed production corresponds to the record information. 
Check for spelling as well as relationships that are linked to the 
filmed production.

•	 	Check the appropriate copyright license to be used; upload signed 
form; follow up if form is missing.

•	 	Check tracking, light and sound. Make note if digital copy needs to 
be edited.

•	 	For CTDA filmed productions, check edits/cuts for the following: 

  à Edition retains overall production’s aesthetics (light, sound, 
music)

  à Close-ups are used whenever needed

  à Transitions in the editing process capture rhythm of the play

  à Cuts in the editing process do not break a unit of intention or 
one chain of actions

  à Edition pays attention to details of stage and light design

  à Sound track is perfectly synchronized with the actor’s dialogues

  à Sound level is as even as possible throughout, maintaining the 
highs and lows of the live performance

  à Edition has included some frames of the audience before and 
after the performance

  à Edition has included pre- or post-performance presentations, 
when applicable 

The Content Specialist meets regularly with videographers to discuss 

edited productions. They discuss cuts and dissolves, choice of camera 

angles, etc. so that every edited production becomes a learning experience 

for all involved.
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ARCHIVING

Once the video has been edited correctly and approved by the 

Content Specialist, we create the approrpiate archival and presentation files. 

Information on the settings used is in the section titled “Initial Setup.”

CREATE DERIVATIVES

1. Open Compressor.

2. Open the 01 QT Reference Files folder on the Desktop.

3. Drag the correct file from the Finder window to the Job Queue in 
Compressor (the down arrow).

4. In the Settings tab, open the Custom folder.

5. Select the 01 through 05 settings and drag them to the Job Queue.

a. For the 01 DPL Archive File, append “-a” to the file name.

6. Repeat steps 3 through 5 for other files as needed.

7. Press Submit:

a. Change the cluster to the computer’s cluster [i.e. Evangelion 
cluster].

b. Press Submit.

After this step is completed, check it off in the database.

FINAL QUALITY CONTROL

•	 	Do all derivatives play?

•	 	Are the files all named correctly?

•	 	Are all the title cards in the correct order?
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CLEANUP OF ALL FILES

Once the video has been approved, the derivatives created, we need 

to upload them to the appropriate servers and then delete the files from the 

computer to make room for the next item(s) in the queue.

1. Upload all derivatives to the Archive Server (FileZilla)

2. Delete Files from Final Cut Server

3. Delete the QuickTime Reference File located in Desktop > 01 QT 
Reference Files

4. Delete all 5 archival derivatives located in Desktop > 02 Compressor 
Output

5. Delete Final Cut Project Files located in Documents > Final Cut Pro 
Documents/ctda

6. Delete Capture Scratch folder files related to the project being 
archived, located in RAID Capture Array > Final Cut Pro Documents 
> Capture Scratch

7. Remove Digital Object from Queue Items List on CTDA Admin 
Website
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